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Cautions and disclaimer
VivoSense® software is not a medical diagnostic tool and is intended for research and investigational
purposes only. VivoSense® is not intended to be, or to replace, medical advice or review by a physician.

Copyright Notice
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1. Introduction
1.1.

Synchronization and Merge Module for VivoSense®

This manual describes the Synchronization and Merge Module for VivoSense®. A brief background on the
problem of synchronization as it relates to physiological data collection will be discussed, and then the
specific features and solutions found in VivoSense® will be outlined.
To use the Synchronization and Merge Module, users must already possess a fully registered copy of
VivoSense® Core application. This is a prerequisite for all supplementary modules and provides the
framework through which interactions with data occur. Likewise, users should be familiar with the import
modules for all desired data types before using this module. As will be explained later, the import and
synchronization processes are tightly integrated, and knowledge of one will help in understanding the other.
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2. Synchronization Background
2.1.

The Integration Problem

VivoSense® is a hardware agnostic physiological data visualization and analysis platform. In addition to
supporting a wide variety of hardware formats, VivoSense® also facilitates the analysis of any other data
through its generic Excel and European Data Format (EDF) imports. Moreover, new hardware platforms are
being added to the system all the time, and so VivoSense® is quickly becoming the single integration point for
any sensor data a user might have.
With streamlined access to data from a wide variety of different sensor systems, the primary complication
after acquisition centers around how to integrate the various recorded data. It is clearly advantageous to be
able to view and interact with all data streams in one synchronized interface, rather than having to use
separate windows (or even applications) to perform one's analysis. However, this goal is deceptively difficulty
to achieve. Numerous obstacles, such as different file formats, non-synchronized start times, and dropped
packets in wireless recordings, all make the process of aligning data from different hardware very
challenging.

2.2.

Synchronization in VivoSense®

The Synchronization and Merge Module in VivoSense® aims to address the above problem through the use
of a streamlined synchronization and merge process that allows users to tie disparate data streams together
using easily understood visual markers and annotations. VivoSense® will further speed up the potentially
tedious synchronization step with its automated synchronization algorithms, which can instantly determine,
with millisecond accuracy, the ideal synchronization point.
The process of combining two sensor data files into one, integrated file is broken up into two distinct steps in
VivoSense®. First, users can use state of the art visualization techniques and algorithms to align the
timestamps of the files in question. Then, in a straightforward and clean interface, users can choose which
channels to merge together into the final file. This allows a very fine level of control over the process, and
gives the user a quick means to eliminate unnecessary channels from the merged file.
These two processes will be discussed in detail below, along with screen shots that illustrate the entire
synchronization and merging procedure.

2.3.

The Synchronization and Merge User Interface

Once the Synchronization and Merge Module has been purchased, a new group of icons will be accessible
on the VivoSense® toolbar (Figure 1).

Figure 1. Synchronization and Merge Icons
The functionality of each of the new icons is explained below:
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Merge Open Files – Clicking this button will begin the merge process for all open files.
Lock Session X Axis – Clicking this button will lock X-axis scrolling for all open sessions.
Toggle Synchronization Layout – Clicking this button will toggle between tabbed and vertically tiled
sessions.
Point Synchronization – Clicking this button will begin the Point Synchronization process.
Annotation Synchronization – Clicking this button will begin the Annotation Synchronization
process.
Intelligent Synchronization – Clicking this button will begin the Intelligent Synchronization process.
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3. Synchronizing Data Files
3.1.

Importing Data

The first step in any VivoSense® analysis is to import data. The synchronization process is no exception as all
data to be synchronized must first be loaded into the software. This step can be performed by going to the
File Menu and selecting 'Import Hardware File', followed by the type of file to import. If the desired data files
have already been imported and saved in the VivoSense® file format, use the 'File > Open .vsn File' option to
load in the data. For more details on the import process, see the VivoSense® Core Manual.

3.2.

Synchronizing Data

The synchronization step is vital in ensuring that data recorded on different sensor hardware are aligned
properly for analysis. To begin the synchronization process, make sure the relevant files have been loaded
into VivoSense® and that their respective sessions tabs are visible.
Next, press the Toggle Synchronization Layout button on the toolbar (
). Your Synchronized Chart Panel
(SCP) will update to show all open sessions, vertically tiled in your main window (Figure 2). This layout is
used to make the synchronization process easier and faster. Once finished with synchronization, click the
Toggle Synchronization Layout button again to switch back to the default tabbed session view.

Figure 2. The Synchronization Layout
One other important concept in aligning two files is the idea of primary and secondary sessions. In this case,
the primary session is the file to which the other sessions will be aligned. In other words, the primary
session's start time remains fixed, whereas the secondary session's timeline is modified to match the
primary's. When performing synchronization operations, the primary session is indicated by the order in which
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sessions are clicked. For instance, with Point Synchronization, when asked to choose parallel points on two
different sessions, the session first clicked by the user will be the primary session and the others, the
secondary sessions.
Users may use a variety of methods to synchronize the data between the sessions shown. Each of these
techniques is accessible from the toolbar menu and is explained in detail below.

Point Synchronization
If the location of two parallel points in time can be located on a channel in each of the sessions, then the
secondary session's time can be updated to match the primary session's timeline. To perform this type of
synchronization, first zoom in on each session until a known parallel time is visible on each chart. Then,
select the Point Synchronization (
) button from the toolbar. A tooltip will appear indicating that you should
select a point on the primary session. Do so by left clicking at the desired location on any chart in the primary
session. A temporary annotation will be created at the point selected (Figure 3). Next, select a corresponding
location on one or more secondary session channels. A temporary annotation will be created for each point
selected, and once a selection has been made for each session, the user will be automatically prompted to
perform synchronization.

Figure 3. Point Synchronization
If edits need to be made to the locations selected, simply click no at the prompt and then choose new
synchronization points. The synchronization annotations will be updated as changes are made.
To only synchronize a subset of the open sessions, select points on the desired sessions and then click the
Point Synchronization button again. A confirmation will be displayed and synchronization can then be
performed on just the selected sessions.
After synchronization is complete, the start times of the secondary sessions will be updated to reflect the
points chosen, and the temporary annotations will be removed. To view the quality of the synchronization, try
using the Lock Session X Axes feature (see Lock Session X Axes section).
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Annotation Synchronization
If the two sessions marked for synchronization both contain an annotation that delimits a similar point in time,
then annotations can be used for alignment. A common example of this would be an event marker that was
inserted at the same time for two different hardware systems during a recording.
To begin using this synchronization method, press the Annotation Synchronization button (
) on the
toolbar. A tooltip with instruction will appear, at which point you may select one annotation from a chart on
each of the sessions. Annotations may be selected by either left clicking on them, or by dragging a region
over an annotation. If region selected contains more than one annotation, the first one will be chosen for
synchronization (Figure 4).

Figure 4. Annotation Synchronization
After a selection has been made for each open sessions (or for a subset as discussed in the Point
Synchronization section), a prompt will be displayed, and synchronization can be performed.
Note: Sessions will be synchronized to the beginning of the annotated regions.

Intelligent Synchronization
Oftentimes, it is possible to precisely align two data streams in time by analyzing the data itself to determine
the point at which the signals best match up. This process can be much faster and significantly more
accurate than manual synchronization for suitable data streams.
To use this method of synchronization, press the Intelligent Synchronization button (
) on the toolbar. A
tooltip message with instructions will appear, at which point you may select a region or an entire chart from
each of the open sessions. An annotation may also be selected to demarcate the desired region for
synchronization.
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Note: If multiple channels are present on a particular chart, then data from the first channel on that
chart will be used for all calculations.
Once selections have been made, VivoSense® will process the data to find the optimal synchronization point.
After each point has been found, a prompt will be presented to the user showing them the proposed new start
time for this session, along with an estimate of the quality of the synchronization. The user may then choose
to use this point, reject it, or cancel the process altogether (Figure 5).

Figure 5. Intelligent Synchronization
Annotations indicating the optimal synchronization point persist for all secondary channels. These can be
reviewed later and removed by the user if desired.
To achieve the highest level of accuracy for intelligent synchronization, it is important to note the following
concepts:
•

The channels chosen for synchronization must exhibit similar shapes or patterns. The magnitude of
the data need not match, but in order to find synchronization points, the characteristics of the data
must be similar. For example, it is possible to match accelerometer data across multiple devices if
they are being worn by the same person. Even if they were worn by different subjects, if a concurrent
event can be found in both recordings (for instance, a tap), it should be possible to synchronize that
region.

•

Although not absolutely necessary, synchronization works best when comparing data with similar
sampling rates. If one channel is sampled at a significantly faster rate, try using a trend channel to
bring it in line with the other channels, and then use the trend for synchronization.
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Cancelling Synchronization
If, after pressing one of the synchronization buttons, the user wishes to not continue with the synchronization
process, he or she may simply press the Escape key, or click on the button of the current synchronization
process. For example, if Point Synchronization is currently being used, and the user decides to cancel, he or
she can just press the Escape key or press the Point Synchronization button again to cancel the operation.
Likewise, any closing or opening of new sessions will also cancel the current synchronization process.

Synchronization Preferences
Synchronization preferences can be found by clicking on the Tools menu item, then selecting Preferences
and opening the Synchronization and Merge tab. The following options are currently available:
1. Intelligent Sync Accuracy. Can be set to Low, Normal, High or Highest, and controls the resolution of
the Intelligent Synchronization algorithm’s search for the optimal synchronization point. Typically, this
option should be left at its default (Normal), but if the results are not satisfactory, the High or Highest
setting may work better. Note: Choosing High or Higher will significantly increase the time
needed to perform Intelligent Synchronization, especially on large, high resolution files.

Reviewing Synchronization: Lock Session X Axes
To facilitate the review of the synchronization process, the Synchronization Module offers a Lock Session X
Axes button (
), which will link all open sessions together so that they show the same timeline. Scrolling
on one will cause scrolling on the other, which allows users to compare how well channels from each session
have been synchronized (Figure 6).

Figure 6. Lock Session X Axes
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Once satisfied with the results, simply click the Lock Session X Axes button again to return to normal
scrolling. Now that your sessions have been synchronized, please refer to the Merging Data Files section to
learn how to merge files together.
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4. Merging Data Files
After files have been synchronized, their data channels can be merged into a single, unified file. This is done
from the File > Merge Open Files menu option, which allows selection of multiple files for merging. The
merging process is described in detail below.

4.1.

Merge Configuration Dialog

The Merge Configuration Dialog looks and operates similarly to the Import Configuration Dialog (see Core
Manual), but serves a slightly different purpose. When you select the Merge Open Files button (
), a list of
all channels available in each of the files in question will populate the leftmost column. Just like the normal
Import Configuration Dialog, the task at this point is to map channels from the leftmost column to channels
that can be handled by VivoSense® (Figure 7).

Figure 7. Merge Configuration Dialog
VivoSense® users will notice that two columns in the Merge Configuration Dialog have changed. The second
column is now the ‘File Name’ column, and it indicates the file to which each channel in the leftmost column
belongs. Additionally, the rightmost column is now the ‘Sample Rate’ column, and it provides a non-editable
view of the sampling rate for each channel.

4.2.

Merging Channels

Typically, when users merge channels from two or more sessions, they want them to remain distinct and
untouched in the new file. For example, perhaps one has a file containing an ECG waveform and three
accelerometer channels, whereas another file recorded at the same time includes two respiration channels.
These six channels represent records of distinct physiological processes, and consequently, can be easily
merged, without conflict, into a new file. However, there are also times when the same sensor data may be
shared across multiple files. An ECG recording may have been done multiple times during a study, with gaps
of a few minutes or hours in between each recording. For these situations, the VivoSense® merge
functionality provides the concept of channel merging.
Channel Merging combines the data from multiple channels across multiple files into the same channel in the
newly merged file. Multiple respiration, ECG, or accelerometer data streams can be combined together to
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create a single, time-synchronized channel. To achieve this, simply choose the same VivoSense® Channel
name for multiple input channels in the Merge Configuration Dialog. After clicking ‘Done’ to begin the merge,
VivoSense® will alert the user that channel merging will occur (Figure 8).

Figure 8. Channel Merging
Note: In cases where data from channels overlaps, the data from the channel with the earliest start
time will be used. Also of note is that for evenly sampled data streams, channel merging may
introduce a timing error of up to (1 / sampling rate) seconds, as the merged channels may not be
perfectly synchronized.

4.3.

Merging Annotations

In addition to the data in the selected channels, annotations will also be merged. If both files contain the
same annotation, only one copy will be kept.

4.4.

Resolving Channel Conflicts

When performing a merge with files that do not contain any of the same sensor types, this process is very
straightforward. However, if the channels exist in two different files, then one needs to make a decision about
how best to configure the merge. If the candidate files together contain more than the allowed number of
channels for a particular sensor type, then the user must select a subset of the available channels for
inclusion. The channels selected can be from the same file or both -- the only constraint is the number
selected.
Although the number of channels supported for each data type is limited, VivoSense® does allow the
specification of up to eight 'Generic' channels, which can be used for any type of data. Users can visualize
and trend these generic channels, but they will not receive the same kind of processing that they otherwise
would if they were specified as say, an ECG or Respiration channel.
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